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CATIA V5R16 and UGS Tecnomatix Jack 5.0  
 
CATIA (Computer Aided Three-dimensional Interactive Application)  
 
CATIA is the most powerful multi platform CAD/CAM/CAE/PLM software package of 
its kind in the world. It was created by the consortium of Dessaults’ System of France 
and IBM of United States.  
 
CATIA works like an integrated digital factory by its own. You can start with a 2D 
sketch of the product, digitally create a full 3D prototype, manufacture it through 
Numerical Control (NC) workbench and manage the development and marketing of this 
product by using Product Lifecycle Management (PLM) utilities. Some of the 
workbenches in CATIA are specially configured for ship design, aerospace sheet metal 
design, A-Class surface design, Finite Element Analysis (FEM), ergonomic design and 
analysis …etc  
 
CATIA helps engineers by integrating all engineering design and analysis tools under a 
single software package. This unique integration brings the advantages of data 
management, consistency in information flow, savings in time and money, rapid product 
development strategies, user productivity, enhanced photorealistic visualization...etc.  
 
NASA’s Space Shuttle program, The Boeing Company, Airbus, US Navy, BMW, 
Mercedes, Audi, Toyota, Ford....etc integrated to CATIA and took a new step towards 
digital design, manufacturing, production and marketing. Purdue is also one of the 
pioneer engineering schools in the world which uses this software campus wide.  
 

  
   Human Centered Design – Development of F-1 Race Car 
           (By Vincent G. Duffy and H. Onan Demirel)  
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JACK  
 
Digital Human Modeling (DHM) facilitates design by reducing the need for prototypes, 
and can be defined as “A digital representation of the human inserted into a simulation or 
virtual environment to facilitate prediction of safety and/or performance. It includes 
visualizations and the math & science in the background (Sundin, 2006). DHM 
applications have potential to enable engineers to incorporate ergonomics & human 
factors engineering principles earlier in the design process (Duffy, 2004; Chaffin, 2005). 
It also provides real cost savings to the industry. ($8.8 Million avoided in injury costs, 
Brazier, et. al. 2003) 
 
Digital Human Modeling helps organizations to design safer and efficient products while 
optimizing the productivity and cost. DHM applications help engineers to improve 
ergonomics and human factors in design and product development. Traditionally DHM 
applications have been utilized by manufacturing and design industry. However, 
technological developments and advancement in the computer applications expands the 
application areas of DHM.  
 
Simulation tools help engineers and scientists to replicate the operation of complex 
systems by using computer software. Advance computer integration in engineering is 
necessary for understanding the complex systems ranging from building jet engines to 
simulation of earthquake shocks. A highly complex system, human body, is investigated 
and analyzed by Digital Human Simulation software. UGS Tecnomatix Jack 5.0 software 
makes this integration possible and provides solution for complex engineering design and 
analysis problems. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
             Human Centered Design – F-1 Driver Comfort Analysis 

(By Vincent G. Duffy and H. Onan Demirel) 
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Integration of CATIA and Jack 
 
The file transfer protocol between CATIA and Jack gives the flexibility of exchanging 
files. Therefore, we can integrate two powerful softwares and combine their power to 
take a further step in design and analysis of advance products and systems. You can 
export your CAD model from CATIA without losing its surface/geometry quality. 
However, none of the file protocols in CATIA and Jack are capable to keep the complete 
mechanical and parametric integrity of advance digital CAD models. Basically, you can’t 
export the history tree, applied materials and solid integrity of CATIA products to Jack. 
Some of 3rd party software can achieve this dual-way transfer process but they are not 
efficient and not cost effective.  There are many research projects and special software 
developments are focused on dual-way embedded file transfer protocols. Besides this 
drawback, current file transfer protocols are still beneficial and they save significant 
time/effort in engineering design and analysis.  
 
In IE486, we are trying to get benefit from two special softwares. We will work on 
Human Performance Analysis and Digital Human Modeling topics by using UGS Jack 
software. Similarly, we will use state-of-art multi-platform engineering software, CATIA, 
to create/modify our CAD models.  This approach gives us a chance to understand the 
human centered design and ergonomics in engineering design.  
 
Modern engineering design and analysis tools focus on the development of macro/micro 
scale advance products and systems. Nowadays, products and systems are becoming 
more human centered. The human-centered design philosophy requires engineers to 
collaborate object oriented design efforts with physical and cognitive aspects of the 
human. This allows engineers to design human and environment friendly efficient 
products which give the true value to the users, human. Imagine a race car with the best 
engine, material and aerodynamics configuration but lack of human safety and usability. 
So, as an engineer you don’t want to be part of this “200+ mile/hr racing coffin” project. 
Therefore, human-machine integrated digital design and analysis tools (ex. CATIA and 
Jack) and the human-centered design philosophy give advantage of replicating reality 
before anything catastrophic happens. Even though our current workstation model may 
look simple, but in reality there is much to learn from it.  
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How to Run CATIA Workstation File  
 
File Management  
 
Please pay special attention while storing/managing files in CATIA. When you create an 
assembly product, CATIA automatically assigns a parametric relation to each component 
in the assembly. Parametric modeling tools use dimension, equations and constraints to 
define geometry in 3D space. This gives the advantage of simultaneous part update. 
When you make a change in any assembly component, you don’t need to modify your 
assembly product. CATIA automatically updates the assembly product. CATIA also 
keeps the history of each construction/modification actions you’ve made on your model. 
This gives you the flexibility of changing parameters quickly. In low-end CAD 
applications you can’t modify your original geometry once you changed it. The 
parametric modeling saves time and money, speeds up the design/analysis phase and 
keeps models consistent.  
 
In order to maintain the consistency of the parametric dimensions, equations and 
constraints, you need to keep your source files and assembly file together in a pre-defined 
folder. Also, don’t change the file names, just save them as they are. (There is a way to 
keep files in different locations and freely move them. However this needs advance 
training and it goes beyond the scope of this class.)  
 
When you download CATIA files from webct, keep them in the same folder. You need 
all 9 files shown below. After downloading all files, you can work with the assembly 
product.  
 
   
 Source Files 

(Assembly Components) 
Type 

1 Conveyer_CAD CATIA Part 
2 Cooler_Drum_CAD CATIA Part 
3 Cutter_CAD CATIA Part 
4 Extruder_CAD CATIA Part 
5 Loading_Table_CAD CATIA Part 
6 MaterialBin_CAD CATIA Part 
7 Skid_CAD CATIA Part 
8 TableBin_CAD CATIA Part 
 

Assembly Files 
(Assembly Product) 

Type 

9 Assembly_Workstation_No_Manikin CATIA Product 
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How to Open CATIA 
 

1) Go to webct; find the Catia Workstation folder under IE486 class link.  
2) Create a new folder in your computer (in my documents, desktop…etc)  
3) Download all the files from Catia Workstation folder to the new folder you’ve 

just created.  
4) Run Catia on ITAP PC (Course software > Technology > cgt > Catiav5r16) 

Be patient when Catia is launching it may take up to 2 – 3 minutes.  
When you see the screen #3 below, click “close” and wait to Catia logo appears. 
Catia should be running after ~30 sec. 
 

 

 1  

 

               

 2   3  
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       5. You should see this screen when CATIA launches.  
 

 
 

6. Now go to File and Open the assembly product file you’ve saved in your 
computer (Assembly_Workstation_No_Manikin)  
 

    
 
7. You should get this workstation environment.  
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2. You can also orient your screen by using Isometric View toolbar. This will 
automatically orient the CATIA screen by using pre-determined views. This tool 
includes Isometric/Front/Back/Right/Left/Bottom/Top views of the objects in the 
CATIA screen.  

 

 
 
3. Alternatively, you can use the icons in View menu and manually 
navigate/rotate CATIA screen.  
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How to Change Object Dimensions in CATIA 
 

1. Open the assembly product file (Assembly_Workstations_No_Manikin) 
See handout “Catia Workstation Instructions”  

 

 
 

2. The file is running on CATIA Assembly Design.  
3. Move your mouse in 3D and pass through the object you want to change its 

dimension. Notice, when you move your mouse a hand icon appears whenever 
you pass through an object.  At the same time, the name of the object is 
highlighted on the history tree.  

 

  

When you pass trough the 
Loading Table, the component 
name is highlighted in the 
history tree.  
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4. Now let’s change the dimension (height) of the Loading table. 
 

a. Expand the Loading Table history tree by clicking the plus icon next to the 
highlighted component name. This is first expansion, we are moving into first 
parametric assembly relation.  Notice, a component with name “6” appears. This 
signifies Loading Table is the 6th assembly component in the assembly product.   

 

 
 

b. Expand the Loading Table history tree once more by clicking the plus icon next 
to the highlighted component name “6”. This is the second expansion, we are 
moving into second parametric assembly relation which guides us to the 
Mechanical Part Design.  
 

 
 
 
 
 
 
 

IE 486  Vincent G. Duffy, Jacqueline A. Sutherland and H. Onan Demirel  10 
 Project and Lab Manual  



c. Once more, expand the Loading Table history tree by clicking the plus icon 
next to the highlighted component name PartBody. This is the last expansion; we 
are in Mechanical Part Model. Every component inside PartBody represents 
special mechanical solid modeling operations. CAD modeling software has 
special construction methodologies where a 2D geometry can be extruded, drilled, 
grooved…etc. For the objective of this class, just try to remember you can only 
change dimensions once you move into PartBody (once you expand your history 
tree until Part Body)  
 
Note: We are in Assembly Design module of CATIA. Take a look at the icon bar 
on right. These icons represent Assembly Design operation tools. Don’t worry 
about the functionality of those icons, we are only interested in to see which 
CATIA module we are in.  
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d. Now we are almost ready to change the dimension of the object. First, we need   
 change CATIA Assembly Design module to Part Design module. Double click on   
            the Loading Table Part Height extrusion pad icon. You will notice the CATIA 
            Assembly Design module changes to Part Design module.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Note: We are in Part Design module of CATIA. Take a look the icon bar on right. 
These icons represent Part Design operation tools. Again don’t worry about the 
functionality of those icons, we are only interested in to see which CATIA 
module we are in.  
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e. Now double click on the Loading Table Height on history tree and a Pad 
Definition dialog box will pop-up. You can change the length of the Loading 
Table by modifying the Length value in Pad Definition window. Please try not to 
modify/input values besides Length value. Any change in other parameter values 
may corrupt the CAD model. 
 
Note: The small arrow button shows the direction of change.  
 

 
 

e. Change the Length value (I used 2m), and click OK. You can also click 
Preview button to see the changes before they are activated. 
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How to Orient Objects in CATIA 
 
Once you change the dimensions in CATIA, you should observe that the objects are not 
sitting in the same plane/level no more. We need to fix the orientation of the objects 
respect to the floor level/plane in order to keep the realistic view and accuracy of the 
CAD model. In order to orient the objects in space we will use the CATIA’s Assembly 
Design Manipulation tool.  
 

1. Remember we changed the dimension (length) of the Loading Table by using Pad 
Window. We were in the Part Modeling module of the CATIA. In order to orient 
the object, we need to go back to Assembly Design module after we confirm 
dimension changes. (Part Modeling  Assembly Design)  

 

  
 

 

a. Your CATIA screen after you made 
the dimension change should look 
similar to figure a. 

b. Go File > Save  
c. Click Yes. (CATIA should 

automatically close the current 
screen. Otherwise, manually close 
your screen after you saved it.)  

d. Go back to the folder/directory that 
you keep your CATIA Workstation 
files.  

e. Double click on assembly product. 
(Catia_Workstations_No_Manikin) 
You should observe that the 
updated part is ready for use in 
Assembly Design module now.  
That’s how we switch between 
Assembly and Product design 
modules.  

a

b

 

   

c
d
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2. Before manipulating the object locations, we need to create a virtual ground/floor 
to fix the objects in a predefined location. This virtual floor will not affect/appear in 
our analysis. It’s a quick and simple visual aid used by designers. Of course in this 
powerful software there is a way to parametrically fix the object level/plane. 
However, this needs previous training and complex at this moment. We will use the 
Ground tool as a visual aid in our workstation design. Go View > Ground and virtual 
ground will appear on your screen.  
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3. Now we have the visual floor to fix the objects in a standard plane/level. 
However, the elevation of the floor and the objects are not leveled. We need to 
attach the floor to the original object level/plane.  

 

 
 

 

a. Select the front view from Isometric 
View toolbar. Now, the digital 
ground appears as a thin line. 
(Because you are looking to the 
screen in front view.)  

b. When locate your mouse on the on 
line, a hand tool appears. Left click 
on the mouse, hold the mouse 
button and try to move the mouse 
until you reach the original object 
level/plane.   

c. Try to match original object 
elevation and the virtual ground.  
Since this is a visual aid tool, it 
might not be the accurate way of 
matching floors. Try to use your 
institutive thinking and visual sense 
to get the best match.  

d. When you rotate the object, you 
should see that the ground level 
elevation is matching with the 
original object plane and The 
Loading Table is partially divided 
by the virtual ground.   

a

b

 

      

d c
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4. Next, we will shift the elevation of Loading Table and try to fix it to the virtual 
ground level. We will use the Manipulation tool of the CATIA’s Assembly 
Design module. When you click the Manipulation tool, Manipulation window 
appears as shown below.  
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5. Now let’s shift the Loading Table. The Manipulation screen is easy to use and  
it helps users to fix the direction/movement in predefined 3D axis plane. We click on 
Z axis (notice a small font note appears, “drag along z axis”) in the first row of the 
Manipulation window. 

 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. When you select Z axis go on Loading Table, locate your mouse on Loading 
Table. When you move your mouse, you will see that the object is highlighted. 
Now, click on left button of your mouse, hold it, and start to move your cursor up. 
You should see that the Loading Table is shifting upwards. Keep shifting the 
Loading Table until you match it with virtual ground plane.  
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7. You should see that there is a slight problem in the orientation. The Loading 
Table is at right elevation (on virtual ground plane) but the skid is just sitting in 
the middle of the Loading Table. We should move the skid to top of the Loading 
Table. We will take the exactly the same actions as we took while moving 
Loading Table. (select Manipulation, select Z axis, shift the skid up to Loading 
Table surface) 

 

    
 
 

8. We fixed the elevation of the objects. You may either keep the virtual ground or 
turn it off from View menu. After you have finished the changes click OK on 
Manipulation window. And you can save your files by File > Save.  
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How to Open Jack  
 
1) How to Login Jack  
  > Login Jack on ITAP computers – Appendix A2  
  > Login Jack off-campus – Appendix A4  
 
2) How to Open a Jack Environment File – Appendix A9  
 
Below figures show some frequently used toolbars. For additional help, please check 
appropriate sections at UGS Tecnomatix Jack 5.0 User Manual and Examples.  
 
 
 
 
 
 

 

Zoom: you can zoom in/out to the part by 
dragging the mouse cursor on the screen 
while keep holding the right button.  

Pan: is used to move the viewpoint around the part 
from either left to right or up or down, or 
combinations of both. You can think pan as rotation 
in 2D plane.   

Rotate: is used to revolve viewpoint location 
around the part. You can analyze the visualization 
on the part in details by dynamically rotating the 
viewpoint around the part.  

 
 

            
    
    
    
    

 

 

Open File to 
Read into the 
Environment 

Save Current Scene 

Toggle 
Session Log 

Viewer 

    
    
    
    
    
    
    
    
    
     
 
 

View 
Contro

Create 
Male

Create 
Female

Human 
Scaling

Human 
Control 
Panel

Zoom View 
to Cursor 

Display of 
Object 

Hierarchy 
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How to Run Jack Workstation File 
 

1. Login to Jack software ( see Jack Manual Appendix A2 - A6) 
a. How to Login Jack on ITAP computers  
b. How to Login Jack from off-campus computers 
  

2. After you launch Jack,  
a. File > Import  
b. Select Jack file (Assembly_Workstations_No_Manikin.wrl)  you’ve 

downloaded from webct  

   
 

3. Now, we need to input some coordinate values to import the –wrl file to Jack  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Scale Factor  100.0
Transform Translation x  -2.0
Transform Translation y 0.6
Rotation X  -90.0

 a   b  
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4. After you input coordinate values, click “Translate”   

You will notice that a pop-up window appears. This window shows the translation 
process. You should see the SUCCESS note at the end of the translation process. 
Basically, your 3D solid CAD model is translated into segments and surfaces. It is 
no more a parametric model; it is translated into a surface/geometry model.  
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JACK Exercise  
 
Metabolic Energy Expenditure (Manual pg. 133 - 141)  
 
Task: A male worker (directly created by “Human Toolbar” pg.35) is assigned to work 
on a simple lifting and carrying task.  Refer to below figures and take a look at the input 
parameters to setup your Metabolic Energy Expenditure task entry. For the purpose of 
this lab please follow the given input values. How to setup NIOSH analysis? Please 
check page 133 at UGS Tecnomatix Jack 5.0 User Manual and Examples.  
 
Steps Movement Type Position 

1 Lift Squat 
2 Carry Arms at side 
3 Push Bench Height 

              Table 1 – Task Work Elements  
 

  
1 

          Fig 1 – step 1 

   
2 

            Fig 2 – step 2 

 
3 

 
                      Fig 3 – step 3  
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NIOSH (Manual pg. 142 - 149)  
 
Task: A male worker (directly created by “Human Toolbar” pg.35) is assigned to work 
on a simple lifting task.  Refer to below figures and take a look at the input parameters to 
setup your NIOSH analysis. For the purpose of this lab please follow the given input 
values. How to setup NIOSH analysis? Please check page 142 at UGS Tecnomatix Jack 
5.0 User Manual and Examples.  
 
Steps Movement Type Position 

1 Lift Squat 
2 Carry Arms at side 

                Table 1 – Task Work Elements 
   

 
                Fig 1 – step 1        Fig 2 – step 2 
 

   

 
1 

 

2 
                    Fig 3 – step 3 
 
 

IE 486  Vincent G. Duffy, Jacqueline A. Sutherland and H. Onan Demirel  24 
 Project and Lab Manual  



               
File Transfer Procedure between CATIA and Jack 
 

1. When you change/modify your parts in CATIA you may export the files to Jack 
by saving as –wrl extension.  

 
 

 
 

2. Now, we can open the file we saved with –wrl in Jack by using Import option.  
Please check “How to run Jack Workstation file”  
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Appendix  
 
 
Supplementary Information; 

 Mechanical Part Drafts 
 Assembly Components 
 Screen shots  
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